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Signature Capture Suite Overview 
Use the Signature Capture suite of Eclipse companion products to electronically capture 
delivery-confirmation signatures. Although the method of capturing signatures differs with each 
application, they each attach signatures to transactions stored on the system. From transactions, 
you can view, print, email, fax, or copy the attached signatures.   

The suite contains the following products:  

• EManifest. 

• EPad. 

• Manifest Processor. 

EManifest 
EManifest is used with Palm devices to collect and upload electronic signatures for storage on 
the Eclipse system. After downloading manifests to a Palm device, drivers can collect signatures 
for each delivery right on the Palm. When the Palm device is synchronized with the system, the 
application attaches the collected signatures to their invoices and manifests.   

EPad 
EPad is a point-of-sale (POS) signature capture device used at sales counters. When customers 
make purchases at sales counters, they sign electronic copies of the invoices using EPad. Sales 
counter personnel then approve the signatures, and the application immediately attaches the 
signatures to their invoices.  

Manifest Processor 
Manifest Processor is used with paper-based, bar coded manifests and scanning software 
technology to capture signatures. When making deliveries, print out manifest tickets with bar 
codes assigned to each order or stop. Drivers collect signatures for each order or stop on the 
printed manifest tickets. After all signatures are collected, scan the signed manifest tickets. The 
application attaches the scanned signatures to their invoices using the bar codes printed on the 
tickets. 

See Also: 
EManifest Overview 

EPad Overview 

Manifest Processor Overview 

Signature Capture and Document Imaging Guidelines 
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Signature Capture and Document Imaging Guidelines 
In order to attach signatures to transactions using the Signature Capture Suite companion 
products, you need to define signature storage locations on the network host. Use the Document 
Imaging companion product to define these storage locations by setting up storage IDs and 
indexing profiles. 

Storage IDs define where certain file types, such as signatures, are stored. Indexing profiles 
define how storage IDs are organized. In short, storage IDs and indexing profiles are electronic 
filing cabinets.  

For example:  

You currently have a filing cabinet in your office holding all signed manifests. Each drawer is 
designated for a different customer. Within each customer's drawer are files for every month of 
the year, holding the signed manifests for the respective month. With the Document Imaging and 
Signature Capture Suite companion products, the network host replaces your filing cabinet, the 
indexing profiles replace each customer's drawer, and the storage IDs replace the files for each 
month of the year.  

For information on how to define storage IDs and indexing profiles, see Defining Document 
Storage Locations. 

Additional Document Imaging Settings for EPad 
In addition to setting up storage IDs and indexing profiles on the network host, you can set up 
temporary storage locations for signatures captured with EPad.  

When you capture signatures using EPad, you commonly do so from counter terminals at your 
warehouse branches. If you capture large amounts of signatures at a branch, set the system to 
temporarily store these signatures on the counter terminals until you can copy them to the 
network host for permanent storage. You must define the temporary signature storage locations 
on each terminal used for EPad.  

Note: Set up temporary storage locations only for terminals that collect a large 
volume of signatures on a daily basis. If you do not capture a large volume 
of signatures at a terminal on a daily basis, you can copy signatures directly 
to the host without temporarily storing them.  

Copy signatures from the terminals to the network host by running a replication. After defining 
both host and temporary storage locations, set up a replication schedule to indicate how often 
stored signatures are copied. For example, schedule a replication to run nightly in order to copy 
all collected signatures from the day.  

In addition to storing and replicating signatures, you need to maintain your warehouse terminals. 
To keep each terminal from becoming overloaded with the temporarily stored signatures, define 
how long to keep the signatures stored on the terminals before the system deletes them. For each 
temporary storage location, you can define the number of days to keep signatures before deleting 
them, as well as schedule a routine purge of the signatures. Just make sure to replicate the 
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signatures to the host often enough so that signatures are permanently stored before being 
deleted.  

See Document Replication Overview for information on how to: 

• Set up temporary storage locations. 

• Schedule replications. 

• Clean out temporary storage locations. 

See Also: 
Document Imaging Overview 

Purging Images 

Signature Capture Suite Overview 
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EManifest Overview 
The EManifest companion product simplifies the collection of delivery-confirmation signatures 
by replacing a paper-based environment with an electronic one. EManifest is used with Palm 
devices to collect electronic signatures and upload them for storage on the Eclipse system.  

The EManifest process is simple: 

• Build manifests as you do for paper-signature deliveries. Instead of printing the manifests 
to collect signatures, download the manifests to defined Palm devices. 

• When delivering, collect all signatures right on the Palm device holding the downloaded 
manifests. The Palm saves all delivery-confirmation signatures, and any attached 
comments entered on the Palm.  

• At the end of the day, upload the saved signatures and comments to the Eclipse system. 
The application automatically attaches signatures to the appropriate invoices and 
comments to the appropriate manifests. 

• In the Eclipse system, access all signatures directly from their invoices and all comments 
directly from their manifests. From the invoice, print, fax, e-mail, or copy the signatures, 
as needed.   

EManifest leaves you with a paper-free environment so you no longer need to spend time filing 
or searching for shipping tickets, or run the risk of losing paper-based confirmation signatures. 

Before using EManifest, make sure to complete all setup tasks. 

See Also: 

EManifest Setup Overview 

Downloading EManifests to Palm Devices 

Collecting Electronic Signatures with EManifest 

Uploading EManifest Signatures 

Using Signatures Attached with EManifest 

Signature Capture and Document Imaging Guidelines 

Signature Capture Suite Overview 
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Downloading EManifests to Palm Devices 
Before using the EManifest application, build the manifest for which to collect electronic 
signatures. In building your manifest, we recommend that you first invoice all orders that you are 
adding to the manifest. If you do not invoice an order, the signature collected could be attached 
to all generations for the order. We also recommend that you create new orders for returns using 
EManifest so that confirmation signatures on returns are not mistakenly attached to the original 
sales order instead of the return. 

After building the manifest, queue it to be downloaded to the Palm device of the delivery person 
who will be collecting the signatures. Remember that this user's Palm ID must be defined in the 
Valid E-Manifest Palm IDs control maintenance record in order to receive the manifest. 

When the manifest is queued, perform a HotSync between the Palm device and terminal. The 
HotSync places the manifest on the defined Palm. The delivery person can now make deliveries 
and collect all confirmation signatures on the Palm device.  

Note: To perform a HotSync, the Palm device's cradle must be connected to the 
terminal through a USB cable or local serial connection. 

To queue an electronic manifest: 

1. From the Whse Mgt > Warehouse Queues menu, select Shipping Manifest Queue to 
display the Shipping Manifest Queue screen. 

2. Build the manifest for which you are collecting electronic signatures.  

3. After building the manifest, use the Lock hot key to lock the manifest and prevent other 
orders from being added to it. 

4. Use the Print hot key to display the Print Options screen. 

5. In the Report Type field, press F10 and select Palm Pilot EManifest Download from 
the displayed list. 

6. In the Show Address and Show Shipping Instructions fields, indicate whether the 
shipping address and instructions should be displayed on the Palm with each delivery 
stop. 

7. Use the Print hot key.  

The system prompts you to "Enter ID of Palm for Download." 

8. At the prompt, enter the ID of the Palm to which you want to send the manifest.  

Note: All Palm IDs for use with EManifest must be defined in the Valid E-
Manifest Palm IDs control maintenance record. These IDs do not need to 
be Eclipse user IDs.  

The system prompts you that the manifest is ready to be synced to the defined Palm. 
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9. Press Enter to return to the Shipping Manifest Queue screen, and press Esc to save the 
manifest and exit the screen. 

10. Perform a HotSync. 

To download the electronic manifest to a Palm device: 

1. Queue the electronic manifest. 

2. Place the Palm device to which you are sending the electronic manifest in its cradle, 
which is connected to the terminal sending data through a USB cable or local serial 
connection. 

3. On the Palm device, tap the HotSync icon to display the HotSync screen. 

4. Tap the HotSync icon to begin the synchronization process.  

5. Once the HotSync is complete, the electronic manifest displays on the Palm's Shipping 
Manifest screen.  

6. You can now collect EManifest signatures for the downloaded manifest. 

See Also: 

Collecting Electronic Signatures with EManifest 

Uploading EManifest Signatures 

Using Signatures Attached with EManifest 

EManifest Overview 

Shipping Manifest Queue Overview 

Sales Management Overview 
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Collecting Electronic Signatures with EManifest 
As soon as a manifest has been downloaded to your Palm device, you can begin collecting 
signatures for all deliveries on the manifest. Depending on settings in the Number of 
Signatures/Barcodes Required On A Manifest control maintenance record, the manifest lists 
individual orders or entire stops on the Palm device. You need to collect delivery-confirmation 
signatures for each listed item. 

On the Palm device: 

• Display order information for all stops.  

• Collect signatures to confirm delivery. 

• Enter comments for deliveries when needed.  

The Palm device saves all signatures and comments, which will be attached electronically to the 
respective invoices and manifests upon upload. 

If you cannot make all deliveries for the manifest, you can clear the undelivered stops from your 
Palm. These stops can then be added to another manifest and downloaded to a Palm device. 

For example:  

You were unable to make all deliveries on the manifest today, and you do not work tomorrow. 
Remove all unsigned stops and HotSync your Palm device with the Eclipse system to upload any 
signed stops. The warehouse manager can add the undelivered stops to tomorrow's manifest, 
which will be downloaded to the Palm device of tomorrow's delivery person.  

To collect an electronic signature for a downloaded manifest: 

1. On the Palm device, tap the Manifest icon to display the Shipping Manifest screen. 

All downloaded manifest stops display. 

Note: Tap the Single-Line/Multi-Line button to toggle between displaying one 
line only for each manifest stop, or the stop number, delivery time, 
company name, and address for each manifest stop. 

2. Select the manifest stop that you need signed. 

Note: If the Record current time as your time-in? dialog box displays, tap Yes to 
select the stop. If you tap No, the system returns you to the Shipping 
Manifest screen and you will need to re-select a stop. 

The Order View screen displays with the delivery information.  

• Tap the Details button to view a list of the orders and items on the delivery.  

• Tap the Order button to return to the delivery stop information. 
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3. Tap the Sign button to display the Approval screen, with the following information: 

• Stop number, projected delivery time, and the customer receiving the delivery. 

• Manifest number for the stop. 

• The current date and time to indicate when the manifest stop was signed. 

4. In the Print Name field, enter the authorizing customer's name. 

5. Hand the Palm device to the authorizing customer. 

6. Ask the customer to sign in the signature box and verify that the name you entered in the 
Print Name field is correct. 

7. Tap the Approve button to accept and save the signature. 

Note: If you approve a signature a second time, the system prompts whether you 
want to override the stored signature and approval date with the new 
information. Tap Yes to override the original signature and date with the 
new signature – if there is one – and date. 

The system returns you to the Shipping Manifest screen. 

8. Repeat the process for all manifest stops on your Palm device. 

9. At the end of the day, upload the collected signatures to the Eclipse system. 

More Options from the Shipping Manifest Screen 

The Shipping Manifest screen also offers these options: 

Menu Options Function 
Clear Stops > Remove 
Unsigned Stops 

Removes any unsigned stops from the Palm device. These stops can either 
be: 
• Downloaded to another Palm device. 
• Added to another manifest and downloaded to a Palm device. 

Purge > Purge All 
Records 

Deletes all manifest stops and attached records from your Palm device. 

More Options from the Order View Screen 

The Order View screen also offers these options: 

Button Function 
Done  Returns you to the Shipping Manifest screen. 

Comments Displays the Additional Comments screen, which you can use to enter any 
comments that you need to attach to the manifest.  
After entering comments, tap the Done button to save the comments and 
return to the Order View screen. 
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More Options from the Approval Screen 

The Approval screen also offers these options: 

Button Function 
Back Returns you to the Order View screen.  

If the authorizing customer has signed the Palm and you tap the Back button 
before tapping the Approve button to save a signature, the system deletes 
the signature. The authorizing customer needs to re-sign for the delivery.  

Comment Displays the Additional Comments screen, which you can use to enter any 
comments that you need to attach to the manifest.  
After entering comments, tap the Done button to save the comments and 
return to the Approval screen. 

See Also: 

Downloading EManifests to Palm Devices 

Uploading EManifest Signatures 

Using Signatures Attached with EManifest 

EManifest Overview 

Setting Up Palm Devices for EManifest 
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Uploading EManifest Signatures 
After deliveries are made and signatures collected, upload all signatures and any additional 
comments to the Eclipse system by performing a HotSync. The system saves the uploaded 
information in the defined storage ID, and attaches all signatures to their respective invoices and 
all comments to their respective manifests.  In addition, the system changes the order 
generation's print status to the setting defined in the Print Status Override On Palm E-Manifest 
Signature Upload control record. 

To upload collected electronic signatures to their invoices: 

1. Place the Palm device holding the signatures in its cradle, which is connected to the 
terminal receiving data through a USB cable or local serial connection. 

2. On the Palm device, tap the HotSync icon to display the HotSync screen. 

3. Tap the HotSync icon to being the synchronization process.  

4. Once the HotSync is complete, all signatures are attached to their respective invoices. 

See Also: 

Collecting Electronic Signatures with EManifest 

Using Signatures Attached with EManifest 

Downloading EManifests to Palm Devices 

EManifest Overview 
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Using Signatures Attached with EManifest 
You can view attached EManifest signature images from their invoices and manifests on the 
Eclipse system. In addition, you can also print, fax, or e-mail the invoices with the attached 
signatures.  

Note: You must have additional code installed with Document Imaging to print or 
fax invoices with attached signatures. You must have VSI-FAX to e-mail 
invoices with attached signatures. Contact Eclipse Advance Technical 
support for more information. 

To view an attached signature and comment: 
1. From the Orders menu, select Sales Order Entry to display the Sales Order Entry 

screen. 

2. Display the invoice you want to view. 

3. Double click on the *i* – displayed in the upper right corner of the screen – to display the 
Attachments screen. 

4. Select the imaged signature from the list and press Enter to display the following: 

• Stop number, projected delivery time, and the customer receiving the delivery. 

• Manifest number for the stop. 

• The authorizing customer's signature and printed name. 

• The date and time when the manifest stop was signed. 

5. After viewing the attached signature, click OK to return to the Sales Order Entry screen. 

6. Press Esc to display the Sales Order Entry Status screen. 

7. Use the Manifest Q hot key to display the manifest on which the order was placed. 

8. Select the order for which to view attached comments. 

9. In the Customer Name/Address field, review the comment underneath the shipping 
information. 

10. Close the manifest, if needed. 

11. Press Esc to save all updates and exit the screen.  

To print, fax, or e-mail an invoice with its attached signature: 

1. From the Orders menu, select Sales Order Entry to display the Sales Order Entry 
screen. 

2. Display the invoice you want to view. 

3. Press Esc to display the Sales Order Status screen. 

4. For the generation to which the signature is attached, place the cursor in the Prt field. 
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5. In the Prt field, press F10 and select one of the following: 

Selection Function 
Y – Yes Print Prints the invoice with the attached signature. 

Press Esc to print the invoice and return to the Sales Order Entry screen. 

F – Fax Faxes the invoice with the attached signature. 
• Press Esc to display the Fax Memo screen. 
• Populate the screen, as necessary. 
• Press Esc to send the fax and return to the Sales Order Entry screen. 

A – E-mail E-mails the invoice with the attached signature. 
• Press Esc to display the e-mail format prompt. 
• At the prompt, enter the format in which to send the e-mail and display the 

Send E-mail screen.  
• Populate the screen, as necessary. 
• Press Esc to send the e-mail and return to the Sales Order Entry screen. 

6. Press F12 to exit the Sales Order Entry screen. 

See Also: 
Uploading EManifest Signatures 

Collecting Electronic Signatures with EManifest 

Downloading EManifests to Palm Devices 

EManifest Overview 

Opening File Attachments 

Using Indexer Menus 

Using Image Tools 

Closing Shipping Manifests 
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EManifest Setup Overview 
Before using EManifest: 

• Install the EManifest application onto all Palm devices that will be used to collect 
signatures.  

• If you do not already have the Document Imaging companion product, obtain and install 
it.  

• If you want to print or fax invoices with attached signatures, install the required code 
with Document Imaging.  

• If you want to e-mail or fax invoices with attached signatures, obtain Outbound E-mail 
and VSI-FAX, if necessary.  

Note: Your Eclipse installer should perform the above setup tasks. If these setup 
tasks were not completed with your initial installation, contact Eclipse 
Advance Technical support. 

After installing the EManifest application, you must set up your Eclipse system, along with the 
Palm devices that will be used for collecting signatures. Define the following: 

• Control and authorization parameters on the Eclipse system.  

• Storage IDs and indexing profiles on the Eclipse system. 

• HotSync preferences for EManifest. 

• EManifest preferences on the Palm device. 

See Also: 

EManifest Overview 

Setup Requirements for EManifest  

Setting Up EManifest HotSync Preferences 

Setting Up Palm Devices for EManifest 

Signature Capture and Document Imaging Guidelines 
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Setup Requirements for EManifest  
Following are the control maintenance records and authorization keys used for EManifest.  

Control Maintenance Records 
Set the following control maintenance records: 

Palm Applications 
• Palm Manifest Administrator Settings 

• Valid E-Manifest Palm IDs 

E-Manifest   
• E-Manifest Signature Document Profile 

Manifest Maintenance 
• Manifest COD Message 

• Manifest Queue Enabled 

• Number Of Signatures/Barcodes Required On A Manifest 

• Print Shipping Instructions On Manifest 

• Print Status Override On Manifest Close 

• Print Status Override On Palm E-Manifest Signature Upload 

• Set Print Status When Order Placed On Manifest 

• Valid Package Types 

• Verify Ship Date/Ship Via For Ready To Manifest 

Authorization Key 
Assign the following authorization key:  

• IMG.EDIT.ALLOWED 
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Setting Up EManifest HotSync Preferences 
Before using EManifest, set up HotSync preferences specific to EManifest. Do the following: 

• Enter an Eclipse serial number to activate the EManifest application.  

• Identify you as the Palm device user so that manifests are sent to the correct Palm device.  

• Ensure that the Palm device can communicate with the Eclipse server.  

To set up EManifest HotSync preferences:  

1. On the Palm device, tap the Manifest icon to display the Shipping Manifest screen. 

2. Tap the Menu screen button to display the EManifest menu bar.  

3. From the Options men, tap HotSync Preferences to display the HotSync Preferences 
screen.   

4. In the User ID field, enter the Eclipse ID of the person who will be using this Palm 
device.  

5. In the Host Name field, enter the name of the Eclipse server.  

Note: You must use a Domain Name Server (DNS) name. You cannot use IP 
addresses. If you do not know the name of the Eclipse server, contact 
Eclipse Advance Technical support.  

6. Tap the Enter Serial No. box to display the Eclipse Serial Number screen.  

7. Enter a serial number assigned for the Palm device and tap OK to return to the HotSync 
Preferences screen. 

 Note: This serial number is required for EManifest to synchronize with Eclipse. 
The serial number assigned to one Palm device cannot be used with any 
other device, and sharing serial numbers violates your licensing agreement. 
If you do not know what the correct serial number is, contact Eclipse 
Advance Technical support.  

8. Select the following options, as needed: 

Option Function 
Sync with Eclipse Uploads signatures to the Eclipse server. 

If you need to HotSync the Palm device to the Eclipse server but do not 
want to upload stored signatures, de-select this option before running the 
HotSync.  
For example, you need to HotSync the Palm device to update information 
for another application and you do not want to upload the signatures at 
this time.  
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Option Function 
Auto Generate Paths Uses automatically generated synchronization paths when running a 

HotSync. 
De-select to display the Set Paths button displays, which you can use to 
define your own synchronization paths: 
• Tap the Set Paths button to display the Sync Paths screen. 
• In the Path to load manifest files from field, enter the pathway of the 

file from which to download manifests to Palm devices. 
• In the Path to save deliveries in field, enter the pathway of the file to 

which to upload collected signatures.  
• Tap OK to save the settings and return to the HotSync Preferences 

screen. 

Note: We recommend that you select Auto Generate Paths. If you want 
to set your own paths, contact Eclipse Advance Technical support. 

9. Tap OK to save settings and exit the screen.  

See Also: 
EManifest Setup Overview 
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Setting Up Palm Devices for EManifest 
Set up EManifest preferences on all Palm devices that will be used to collect delivery-
confirmation signatures. Preferences determine how information displays for each listed manifest 
both before and after signatures are collected. 

To set up a Palm device for EManifest: 

1. On the Palm device, tap the Manifest icon to display the Shipping Manifest screen. 

2. Tap the Show button to display the Manifest Preferences screen. 

3. Select the following preferences, as needed: 

Option Function 
Show Completed Stops Keeps stops displayed on the Palm after they have been signed.  

De-select to remove signed stops from the displayed list. 

Multi-Line Display Displays the stop number, delivery time, company name, and address for 
each stop. 
De-select to display one line only for each stop. 

Note: You can also tap the Single-Line/Multi-Line button on the bottom 
of the screen to toggle between views. 

Show Approval Dates Displays the date a manifest stop is signed next to each listed item. 
De-select to display the manifest stop's shipping information only. 

Show Checkboxes Displays check boxes next to each listed manifest stop. When a manifest 
stop is signed and the Show Completed Stops preference is selected, the 
check boxes display with checkmarks. 
De-select to display the listed manifest stops without check boxes. 

Show Time-In Prompt Prompts you with the actual time at which you are having the manifest 
signed. 
De-select to not be prompted with the actual time at which you are having 
the manifest signed. 

Note: The actual time at which you have a manifest stop signed is 
recorded with the signature, whether or not this option is selected. 

4. After defining preferences, tap the OK button to apply the preferences and return to the 
Shipping Manifest screen. 

See Also: 
EManifest Setup Overview 
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EPad Overview 
The EPad companion product captures point-of-sale (POS) signatures electronically and attaches 
them to the appropriate invoices. EPad consists of EPad Signature Capture devices attached to 
your sales counter terminals and Eclipse Electronic Signature Capture application installed on 
those same terminals.  

The EPad process for capturing signatures at your sales counters is simple: 

• Capture signatures on an EPad Signature Capture device. 

• Attach signatures to their appropriate invoices through a click of a button on the Eclipse 
Electronic Signature Capture window.  

• View, print, fax, or e-mail signatures from their invoices on the Eclipse system. 

• Replicate signatures from the sales counter terminal to the network host, which 
permanently stores the signatures, as needed.  

• Maintain your EPad system by deleting old signatures from their temporary storage 
locations to keep sales counter terminals from becoming overloaded, as needed. 

EPad leaves you with a paper-free environment so you no longer need to spend time filing or 
searching for signed invoices, or run the risk of losing paper-based sales order signatures. 

Before using EPad, make sure to complete all setup tasks. 

See Also: 

EPad Setup Overview 

Capturing Signatures with EPad 

Using Signatures Attached with EPad 

Troubleshooting EPad 

Signature Capture and Document Imaging Guidelines 

Signature Capture Suite Overview 
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Capturing Signatures with EPad 
Signatures captured with EPad are automatically attached to their invoices on the Eclipse system.  

Capturing signatures with EPad is simple: 

• As soon as order generations are entered and invoiced, display the invoice on the Eclipse 
Electronic Signature Capture window. 

• Customers sign for the transaction on the EPad Signature Capture device connected to the 
sales counter terminal.  

• Signatures are then transmitted from the EPad Signature Capture device to the Eclipse 
Electronic Signature Capture window. 

• Once you accept the signature, the system attaches the signature to the invoice on the 
Eclipse system.  

Note: The settings defined in EPad Settings Maintenance or Eclipse Signature 
Capture Settings determine how you can use the Eclipse Electronic 
Signature Capture window. Define all settings before using EPad to capture 
signatures. 

To capture a customer signature with EPad: 

1. Enter the customer order. 

2. At the terminal attached to the EPad Signature Capture device, display the Eclipse 
Electronic Signature Capture window. 

3. Do one of the following to display the customer's invoice: 

• Click the Get Recent Invoices button.  

• If defined, the system prompts you to enter the user ID of the order writer for the 
invoice. Edit the user ID, as needed, and click OK. 

• The system displays the most recent invoices for the customer.  

• Select the invoice from the displayed list and click OK. 

• In the Customer field, enter either the customer name or the order writer name.  

• The system displays the most recent invoices for the customer or order writer, as 
appropriate.  

• Select the invoice from the displayed list and click OK. 

• In the Invoice Number field, enter the invoice number.  

The system populates the Customer and Invoice Number fields, as needed. 

4. In the Signature Name field, enter the name of the customer who is signing for the 
transaction, as needed.  
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5. Ask the customer to sign on the EPad Signature Capture device.  

The customer's signature displays on the Eclipse Electronic Signature Capture window 
just as it does on the EPad Signature Capture device. 

6. Click the Accept button to accept the signature, attach it to the invoice, and minimize the 
window if defined.  

More Options from the Eclipse Electronic Signature Capture Window 

The Eclipse Electronic Signature Capture window also offers these options: 

Button Function 
Clear Signature Clears the customer's signature. The customer must re-sign for the invoice. 

At the displayed dialog box, click Yes to clear the signature. 

Clear All Clears all information from the Eclipse Electronic Signature Capture 
window, along with the signature. The information must be re-entered, and 
the customer must re-sign for the invoice.  
At the displayed dialog box, click Yes to clear the window display. 

See Also: 
EPad Preferences 

Setting Up Host EPad Preferences 

Setting Up EPad Preferences by Branch 

Setting Up EPad Preferences by POS Location 

Using Signatures Attached with EPad 

EPad Overview 

Troubleshooting EPad 
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Using Signatures Attached with EPad 
After a customer signs for a transaction on the EPad Signature Capture device and you accept the 
signature, the system attaches the signature to the invoice on the Eclipse system. View the 
attached signature from the invoice on the Eclipse system.  

In addition to viewing signatures, you can print, fax, or e-mail the invoices with the attached 
signature. 

Note: You must have additional code installed with Document Imaging to print or 
fax invoices with attached signatures. You must have VSI-FAX to e-mail 
invoices with attached signatures. Contact Eclipse Advance Technical 
support for more information. 

To view an attached signature: 

1. From the Orders menu, select Sales Order Entry to display the Sales Order Entry 
screen. 

2. Display the invoice you want to view. 

3. Double click on the *i* – displayed in the upper right corner of the screen – to display the 
Attachments screen. 

4. Select the imaged signature from the list to display the following: 

• The authorizing customer's signature and printed name. 

• The invoice number. 

• The date and time on which the customer signed for the invoice. 

5. After viewing the attached signature, click OK to return to the Sales Order Entry screen. 

6. Press Esc and then F12 to exit all screens. 

To print, fax, or e-mail an invoice with its attached signature: 

1. From the Orders menu, select Sales Order Entry to display the Sales Order Entry 
screen. 

2. Display the invoice you want to view. 

3. Press Esc to display the Sales Order Status screen. 

4. For the generation to which the signature is attached, place the cursor in the Prt field. 

5. In the Prt field, press F10 and select one of the following: 

Selection Function 
Y – Yes Print Prints the invoice with the attached signature. 

Press Esc to print the invoice and return to the Sales Order Entry screen. 
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Selection Function 
F – Fax Faxes the invoice with the attached signature. 

• Press Esc to display the Fax Memo screen. 
• Populate the screen, as necessary. 
• Press Esc to send the fax and return to the Sales Order Entry screen. 

A – E-mail E-mails the invoice with the attached signature. 
• Press Esc to display the e-mail format prompt. 
• At the prompt, enter the format in which to send the e-mail and display the 

Send E-mail screen.  
• Populate the screen, as necessary. 
• Press Esc to send the e-mail and return to the Sales Order Entry screen. 

6. Press F12 to exit the Sales Order Entry screen. 

See Also: 
Capturing Signatures with EPad 

Signature Capture and Document Imaging Guidelines 

EPad Overview 

Troubleshooting EPad 

Opening File Attachments 

Using Indexer Menus 

Using Image Tools 
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Troubleshooting EPad 
If signatures are not attaching to their invoices, use the following two functions to help 
troubleshoot the issue: 

• Imaging Invoice Exception Report – Use to determine which invoices have signatures 
attached. This is useful in sorting out which transactions, if any, are missing signature 
attachments. 

• Reprocess Msg-Ack Utility – Use to reprocesses any images that are stuck in the msg-in 
directory by moving them to the msg-ack directory. From the msg-ack directory, the 
system can attach the signature images to their invoices.  

See Also: 

EPad Overview 

Running the Imaging Invoice Exception Report 

Running Additional Imaging Reports 
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EPad Setup Overview 
Before using EPad: 

• Connect the EPad Signature Capture device to the terminal at your sales counter. 

• Install the Eclipse Electronic Signature Capture application.  

• If you do not already have the Document Imaging companion product, obtain and install 
it.  

• If you want to print or fax invoices with attached signatures, install the required code 
with Document Imaging.  

• If you want to e-mail or fax invoices with attached signatures, obtain Outbound E-mail 
and VSI-FAX, if necessary.  

Note: Your Eclipse installer should perform the above setup tasks. If these setup 
tasks were not completed with your initial installation, contact Eclipse 
Advance Technical support. 

After all components are installed, you must set up your Eclipse system, along with the EPad 
Signature Capture devices that will be used for collecting signatures. Define the following: 

• Control and authorization parameters on the Eclipse system. 

• Document Imaging parameters on the Eclipse system. 

• EPad preferences. 

See Also: 

EPad Overview 

Setup Requirements for EPad 

EPad Preferences 

Setting Up Host EPad Preferences 

Setting Up EPad Preferences by Branch 

Setting Up EPad Preferences by POS Location 

Signature Capture and Document Imaging Guidelines 
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Setup Requirements for EPad 
Following are the control maintenance records and authorization keys used for EPad.   

Control Maintenance Records 
Set up the following control maintenance records: 

EPad 
• EPad Signature Document Profile 

• Print Status Override On EPad Signature Upload 

• Prompt For COD Payment During EPad Signature Capture 

Imaging 
• Valid Imaging Auth Keys 

Authorization Key 
Assign the following authorization key: 

• IMG.EDIT.ALLOWED 
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EPad Preferences 
Before using EPad Signature Capture devices and Eclipse Electronic Signature Capture 
application, set up the device and application preferences.  

You can set these preferences at three different levels: 

• Host – Setting preferences at this level determines all branch and point-of-sales (POS) 
location preferences. These settings can be overridden at the branch and POS level if 
defined.   

• Branch – Setting preferences at this level determines a single branch's preferences, along 
with all POS locations within the branch. Branch settings can be overridden at the POS 
level if defined. 

• Individual POS devices – Setting preferences at this level determines a single POS 
location's settings only, and overrides both host and branch settings if defined.  

EPad preferences are grouped into three areas – Validation, General, and Communication 
Preferences. They are the same whether defined in EPad Settings Maintenance or Eclipse 
Signature Capture Settings.  

Validation Preferences 
Set up validation preferences to define the following entry requirements on the Eclipse 
Electronic Signature Capture window. 

• Requirement Preferences: 

• Define which fields must be populated before a customer can sign for a transaction.  

• Define whether counter personnel can display an invoice by manually entering it or 
whether they must select it from a list of the customer's or order writer's most recent 
transactions. 

• Define whether the EPad system prompts counter personnel to enter the order writer's 
ID when selecting invoices from the system.  

For example: 

If the order writer is the same user as the counter person and the only one to use the 
terminal with EPad, you do not need to activate this preference. If the order writer 
and counter person are different users or more than one person uses EPad on the 
terminal, then activate this preference so the correct order writer can be identified.  

Note: The system defaults the order writer to the last person who used EPad on 
the terminal. 

• Invoice Validation Number Preferences – Define whether invoice numbers must be 
validated against a defined format, and if so, what the format is. For example, define 
whether generation numbers are required when counter personnel enter or select invoices. 
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Note: The order ID and generation number lengths are pre-defined for the entire 
Eclipse system and cannot be edited when defining validation formats. 

General Preferences 
Set up general preferences to define how and when the Eclipse Electronic Signature Capture 
window displays, along with the following: 

• The document imaging profile in which to store signatures if you do not want to use the 
profile defined for the network host in the EPad Signature Document Profile control 
maintenance record. If you temporarily store signatures on the terminal before replicating 
to the network host, enter the temporary storage location for this preference.  

• The description prefix to identify signature attachments from invoices.  

For example:  

Enter Sig: as the description prefix. When a user displays the Attachments screen from an 
invoice, the attached signature is displayed in the attachments list as Sig: Customer 
Name. 

• Whether to use the information entered by the counter person or the information from the 
system. 

For example:  

The counter person enters the customer as John Jones. In the system, the customer is 
identified as John H. Jones. When the counter person selects the invoice, the system 
replaces John Jones with John H. Jones if this preference is selected. 

• The amount of pressure needing to be applied to the EPad Signature Capture device when 
signing.  

Communications Preferences 
Set up communication preferences to define the host to which to replicate signatures and the 
terminal with which the EPad Signature Capture device is being used.  

In addition, define the following: 

• The maximum number of most recent invoices from which the counter person can choose 
when selecting invoices from the system. 

For example: 

If you enter 10 as the maximum number and the customer has 20 transactions on record, 
only the most recent 10 transactions display for the counter person. If the customer has 
only five transactions on record, all five display.  

• The number of seconds the EPad device tries to contact the host before timing out. 

See Also: 
Setting Up Host EPad Preferences 
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Setting Up Host EPad Preferences 
Before using EPad to collect signatures for invoices, define host preferences. These preferences 
determine the settings for EPad Signature Capture devices and the Eclipse Electronic Signature 
Capture application at all of your branches and point-of-sale (POS) locations. Host preferences 
can be overridden at each branch and POS location if you define the host settings as editable. 

For example: 

You set the host communication time out preference to 30 seconds. If the EPad application 
cannot communicate with the host in the 30 second time frame, it stops communication. One of 
your POS locations has a slower connection, however, and normally takes up to a minute for the 
EPad application to contact the host. So you define the communication time out preference as 
editable in order for the POS location to increase the preference to a minute. 

For definitions of each preference, see EPad Preferences. 

To set up host EPad preferences: 

1. From the System > System Files menu, select ePad Settings Maintenance to display 
the ePad Settings Maintenance screen.  

2. In the Branch/DFLT field, enter default to create host EPad preferences for all branches 
and POS locations.  

The Order ID Length and Gen Length fields display the system-wide order ID lengths 
and generation number lengths respectively. 

3. Set host preferences for the following items by entering a preference value: 

Item Value 
Sensitivity (1-100) A numeric value from 1 to 100 to define the pressure threshold 

for all EPad devices.  
We recommend entering 1 as the pressure threshold.  

Communication timeout (sec) The number of seconds that all EPad applications will try to 
contact the host before timing out.  

Require user ID for requests Whether the EPad system prompts for the order writer's ID when 
using the Get Recent Invoices button on the Signature Capture 
window.  

Max items returned on requests The maximum quantity of invoices from which the counter 
person can select. 

Signature description prefix How a signature attachment is identified when selected from the 
Attachments screen of an invoice.  

Signature attachment profile The document imaging profile in which signatures are stored. 
The profile entered in this field overrides the profile defined in 
the EPad Signature Document Profile control maintenance 
record.  

Always replace with host data Whether to replace any information populated into the Signature 
Capture window with information from the selected invoice. 
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Item Value 
Require account name Whether to require the Customer field on the Signature Capture 

window to be populated before the counter person can accept the 
customer's signature.  

Require signature name Whether to require the Signature Name field on the Signature 
Capture window to be populated before the counter person can 
accept the customer's signature. 

Require invoice number Whether to require the Invoice Number field on the Signature 
Capture window to be populated before the counter person can 
accept the customer's signature. 

Allow manual invoice number 
entry 

Whether to allow the counter person to display an invoice by 
manually entering the invoice number on the Signature Capture 
window. 
Enter No to black out the Invoice Number field so that manual 
entry is not allowed. Counter personnel must use a different 
method to display the invoice.  

Require 'S' as first character Whether to require the invoice number to have an S as its first 
character. 

Require gen on invoice numbers Whether to require a generation number as part of the invoice 
number. 
If set to Yes, this preference requires the counter person to select 
the order generation for which the customer signs. 

Validate order ID length Whether to require the invoice number to meet the order ID 
length requirement as displayed in the Order ID Length field. 
For example, if the system-defined order ID length is 10, then all 
invoice number entries must have 10 characters to be valid 
entries.  

Note: The invoice number length includes the S but not the 
generation number. 

Validate generation number 
length 

Whether to require the generation number to meet the generation 
number length requirements as displayed in the Gen Length 
field. 
For example, if the system-defined generation number length is 
three, then all generation numbers must have three characters for 
be valid entries. 

Note: The generation number length includes all characters after 
the dot (.) in the invoice number.  

Note: You cannot activate this preference if you did not enter 
Yes in the Validate order ID length field.  

4. In the Editable field for each item, enter Yes or No to indicate if the item is editable at 
your branches and POS locations.  

5. Press Esc to save your updates and exit the screen. 
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Setting Up EPad Preferences by Branch 
After defining host EPad preferences, you can define unique preferences for individual branches 
or territories. These preferences apply to all point-of-sale (POS) locations within the branch or 
territory, but they can be overridden at each POS location if you define the host settings as 
editable. 

To define unique preferences for a branch or territory, we recommend that you copy the host 
preferences to the branch or territory. By copying the host preferences, you do not need to re-
define each preference. Instead, you only need to edit those values that are unique to the branch 
or territory. If you want to define completely new preferences for a branch or territory, you can 
skip copying the host preferences and define all new preferences.  

For definitions of each preference, see EPad Preferences. 

To set up unique EPad preferences for a branch or territory: 

1. From the System > System Files menu, select ePad Settings Maintenance to display 
the ePad Settings Maintenance screen.  

2. In the Branch/DFLT field, enter default to display the host EPad preferences for all 
branches and POS locations.  

Note: If you do not want to base the branch's or territory's EPad preferences off 
the host preferences, skip to step 7.  

3. Use the Copy hot key to display the Copy To screen. 

4. In the Br/Terr/All field, enter the branch or territory for which to define preferences 
based on the host settings. Enter All to copy the host preferences to all branches and 
territories. 

5. Press Esc to copy the host preferences to the indicated branch or territory, and to re-
display the host EPad settings. 

6. Press Esc to clear the ePad Settings Maintenance screen of the host values. 

7. In the Branch/DFLT field, enter the branch or territory for which you are defining 
unique preferences.  

The system displays the host preferences if you copied the preferences. Otherwise the 
preference values are not populated.  

8. For each item, edit or enter the value as needed. 

9. In the Editable field for each item, enter Yes or No to indicate if the item is editable at 
your POS locations for the branch or territory.  

10. Press Esc to save your updates and exit the screen.  

See Also: 

EPad Preferences 
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Setting Up EPad Preferences by POS Location 
If the host and branch EPad preferences are editable and you need to set up unique preferences at 
your point-of-sales (POS) locations, use the following windows to define these unique 
preferences. 

For definitions of each preference, see EPad Preferences. 

Validation Preferences 
Set up validation preferences to define the entry requirements on the Eclipse Electronic 
Signature Capture window. 

To set up EPad validation preferences for a single POS location: 

1. Display the Eclipse Electronic Signature Capture window on your terminal. 

2. From the File menu, select Settings to display the Eclipse Signature Capture Settings 
window. 

3. Click the Validation tab to display the Validation section of the window. 

4. In the Requirement Preferences area of the window, select the following preferences, as 
needed: 

Preference Function 
Require Customer Requires the Customer field to be populated before the counter 

person can accept the customer's signature. 

Require Signature Name Requires the Signature Name field to be populated before the 
counter person can accept the customer's signature. 

Require Invoice Number Requires the Invoice Number field to be populated before the 
counter person can accept the customer's signature. 

Manual Invoice Number 
Entry 

Allows the counter person to display the invoice by manually 
entering the invoice number. 
De-select this preference to black out the Invoice Number field so 
that manual entry is not allowed. Counter personnel must use a 
different method to display the invoice.  

Prompt for User ID for 
Eclipse Requests 

Prompts for the order writer's ID when using the Get Recent 
Invoices button. 

5. In the Invoice Number Validation area of the window, select the following preferences, 
as needed: 

Preference Function 
Require 'S' for First 
Character 

Requires the invoice number to have an S as its first character. 

Require Generation Number 
on Entered Invoice Numbers 

Requires a generation number as part of the invoice number.  
This setting requires the counter person to select the order generation 
for which the customer signs. 
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Preference Function 
Validate Order ID Length Requires the invoice number to meet the order ID length requirement 

as displayed in the Order ID Length (including 'S') field.  
For example, if the system-defined order ID length is 10, then all 
invoice number entries must have 10 characters to be valid entries. 

Note: The invoice number length includes the S but not the 
generation number. 

Validate Generation 
Number Length 

Requires the generation number to meet the generation number length 
requirement as displayed in the Generation Number Length field.  
For example, if the system-defined generation number length is three, 
then all generation number entries must have three characters to be 
valid entries. 

Note: The generation number length includes all characters after the 
dot (.) in the invoice number. 

Note: You cannot select this preference if you did not select the 
Require Generation Number on Entered Invoice Numbers 
preference. 

6. In the Example Invoice Number field, verify that the example correctly defines the way 
all invoices need to be entered.  

7. Click the OK button to save the settings and exit the window. 

General Preferences 
Set up general preferences to define how and when the Eclipse Electronic Signature Capture 
window displays, along with other miscellaneous settings. 

To set up general EPad preferences for a single POS location: 

1. Display the Eclipse Electronic Signature Capture window on your terminal. 

2. From the File menu, select Settings to display the Eclipse Signature Capture Settings 
window. 

3. Click the General tab to display the General section of the window. 

4. In the Attachment Settings area of the window, set the following preferences, as needed. 

Preference Function 
Signature Profile Defines the document imaging profile in which signatures are 

stored. 
The profile entered in this field overrides the profile defined for 
the host in the EPad Signature Document Profile control 
maintenance record.  
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Preference Function 
Description Prefix Defines how a signature attachment is identified when selected 

from the Attachments screen of an invoice. 
The Example Description field shows how signature 
attachment will display in the Attachments screen. 

Minimize after accepting a 
signature 

Minimizes the window on the terminal after a customer sings 
and the counter personnel accepts the signature.  

Always replace entered data with 
information from Eclipse 

Replaces any information populated into the window with 
information from the selected invoice. 

Starting Cursor Location Defines the field to which the cursor defaults when the window 
is opened: 
• Customer field. 
• Signature Name field. 
• Invoice Number field. 

5. In the Pressure Threshold field, drag the button to set the threshold to 10. 

6. Click the OK button to save the settings and exit the window. 

Communications Preferences 
Set up communication preferences to define the host to which to replicate signatures and the 
terminal with which the EPad Signature Capture device is being used, along with additional 
communication preferences.  

To set up EPad communication preferences for a single POS location: 

1. Display the Eclipse Electronic Signature Capture window on your terminal. 

2. From the File menu, select Settings to display the Eclipse Signature Capture Settings 
window. 

3. Click the Communications tab to display the Communications section of the window. 

4. In the Terminal ID field, enter the ID of the Eterm terminal to which the EPad device is 
connected. 

Note: To access the Eterm terminal ID, from Eterm select the Configure > 
Communications menu to display the Configure Communications 
window. The ID is displayed in the ID field.  

5. In the Eclipse Host Information area of the window, set the following two preferences: 

Preference Function 
Host IP Address The network host to which you are replicating signatures. 

Note: We recommend that you enter the host name as opposed to the host IP 
address. To access the host name, from Eterm select the Configure > 
Communications menu to display the Configure Communications window. 
The host name is displayed in the Host field.  
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Preference Function 
Host Port The network host port.  

To find the host port, display the Phantom Status screen. The port number is 
displayed in the Status field and consists of five alphanumeric characters, 
such as zzzzz.  

6. Click the Test Communications button to make sure that the EPad device is 
communicating correctly with the host. 

• If you set up communications correctly, the system prompts you with "You have 
successfully communicated with the host!". Click the OK button to continue. 

• If you set up communications incorrectly, the system prompts you with "The 
connection to the host could not be established! Check your settings and try again!". 
Click the OK button to return to the Eclipse Signature Capture Settings window and 
re-enter the Eclipse host information. 

7. In the Maximum Number of Items to Retrieve from Host on Each Communication 
field, drag the button to define the maximum quantity of invoices from which the counter 
person can select. 

8. In the Eclipse Communication Timeout Length field, drag the button to define the 
number of seconds that the EPad device will try to contact the host before timing out. 

9. Click the OK button to save the settings and exit the window. 

See Also: 

EPad Preferences 

Setting Up Host EPad Preferences 

Setting Up EPad Preferences by Branch 

Signature Capture and Document Imaging Guidelines 
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Manifest Processor Overview 
Use the Manifest Processor companion product to electronically attach delivery-confirmation 
signatures to their invoices in the Eclipse system. The application works with conventional 
paper-based manifests that you scan after signatures are collected. Using the scanned manifest 
images, the application electronically attaches signatures by reading barcodes printed with each 
signature line on a manifest, and using the barcodes to identify to which invoices signatures need 
to be attached.  

Using Manifest Processor is simple: 

• Create paper-based manifests for deliveries. When printing the manifests, use the barcode 
format to print barcodes for each order or stop on the manifest. 

• When delivering, collect all signatures on the paper-based manifests. 

• At the end of the day, scan each manifest and save the images in a special manifest 
processor directory. 

• Use the Manifest Processor application to crop out each signature on a manifest and 
attach the signature to the appropriate invoice on the Eclipse system. You can process a 
single manifest image separately or all manifest images in the Manifest Processor 
directory simultaneously.  

• In the Eclipse system, access the signature directly from its invoice. From the invoice, 
print, fax, e-mail, or copy the signature, as needed. 

• If the application cannot process a manifest signature, it prompts you that a misread error 
occurred. Following the application's directions, identify the reason why the signature 
could not be processed and manually select the signature to attach it to its invoice.  

Manifest Processor electronically files all manifest signatures with their appropriate invoices. 
You no longer need to spend time filing or searching for signed manifests, or run the risk of 
losing paper-based confirmation signatures. 

Before using Manifest Processor, make sure to complete all setup tasks.  

See Also: 

Creating Manifests for Manifest Processor 

Collecting Signatures for Manifest Processor 

Processing Signatures with Manifest Processor 

Auto-Processing Signatures with Manifest Processor 

Handling Misreads in Manifest Processor 

Using Signatures Attached with Manifest Processor 

Manifest Processor Setup Overview 

Signature Capture and Document Imaging Guidelines 
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Creating Manifests for Manifest Processor 
Before using the Manifest Processor application, build the manifests for which to collect the 
signatures. In building your manifests, we recommend that you first invoice all orders that you 
are adding to the manifests. If you do not invoice an order, the signatures collected could be 
attached to all generations for the order.  

When printing the manifests, select a format to include barcodes and signature lines for all orders 
or stops as defined in the Number of Signatures/Barcodes Required On A Manifest control 
maintenance record. You can define a printing format to which to default in the Default Manifest 
Report Type control maintenance record.  

To create a manifest to use with Manifest Processor: 

1. From the Whse Mgt > Warehouse Queues menu, select Shipping Manifest Queue to 
display the Shipping Manifest Queue screen. 

2. Build the manifest for which you are collecting signatures.  

3. After building the manifest, use the Lock hot key to lock the manifest and prevent other 
orders from being added to it. 

4. Use the Print hot key to display the Print Options screen. 

5. In the Report Type field, press F10 and select one of the following: 

Report Type Description 
Full Manifest w/ BC & Ship 
Tickets 

Prints the manifest with barcodes and signature lines for each order or 
stop, as defined in the Number of Signatures/Barcodes Required On A 
Manifest control maintenance record.  
This option also prints shipping tickets for each order on the manifest. 

Full Manifest w/ BC Prints the manifest with barcodes and signature lines for each order or 
stop, as defined in the Number of Signatures/Barcodes Required On A 
Manifest control maintenance record.  

6. In the Show Address and Show Shipping Instructions fields, indicate whether the 
shipping address and instructions should be printed on the manifest with each delivery 
stop. 

7. Use the Print hot key to print the manifest and return you to the Shipping Manifest 
Queue screen. 

8. Press Esc to save the manifest and exit the screen. 

See Also: 

Collecting Signatures for Manifest Processor 

Processing Signatures with Manifest Processor 

Auto-Processing Signatures with Manifest Processor 
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Collecting Signatures for Manifest Processor 
Collect signatures for each order or stop on a manifest, as defined in the Number of 
Signatures/Barcodes Required On A Manifest control maintenance record. 

Before collecting each signature, make sure to count and record the number of items delivered to 
the customer. When the customer signs for the delivery, he or she is acknowledging the number 
of items delivered.  

To collect a signature for Manifest Processor: 

1. Deliver the stop on the manifest. 

2. With the authorizing customer, count the number of items being delivered for the order or 
stop. 

3. On the manifest, enter the number of items on the order's or stop's # Items line. 

4. On the manifest, have the authorizing customer sign and print his or her name, and enter 
the current date. 

5. After making all deliveries and returning to the warehouse, give all signed manifests to 
the warehouse personnel in charge of processing the manifest signatures.  

See Also: 

Creating Manifests for Manifest Processor 

Processing Signatures with Manifest Processor 

Auto-Processing Signatures with Manifest Processor 

Manifest Processor Overview 
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Processing Signatures with Manifest Processor 
Use the Manifest Processor application to automatically attach manifest signatures to their 
invoices.  

After scanning a manifest, select it from the Manifest Processor application and process it. The 
application electronically attaches the manifest's signatures by reading barcodes printed with 
each signature line on a manifest, and using the barcodes to identify to which invoices signatures 
need to be attached. If the system cannot successfully process a signature, use the Misread 
function to identify and resolve the error.  

Before processing signed manifests, do the following: 

• Create the Manifest Processor directory either on the terminal being used with Manifest 
Processor or on your network. Use this directory to store all scanned manifest images. 

• Set up your scanner to scan images at 600 x 600 dots-per-inch (dpi) resolution. This 
resolution is needed to accurately capture barcodes and their corresponding signatures on 
the manifests, and then attach signatures to their invoices.  

To process signatures with Manifest Processor: 

1. Scan each signed manifest at 600 x 600 dpi resolution, and store the scanned manifests in 
the Manifest Processor directory on your terminal or network. 

Note: If you have the Use faster (but less accurate) barcode scanning option 
selected, you can scan manifests at a lower dpi resolution. We do not 
recommend selecting this option. 

2. Display the Eclipse - Manifest Processor window on your terminal. 

3. In the Eclipse - Manifest Processor window, display the Manifest Processor directory by 
doing one of the following: 

• In the Directory field, enter the pathway for the Manifest Processor directory. The 
system displays the directory in the body of the window. 

• Click on the Browse For Folder icon – located to the right of the Directory field – to 
display the Browse For Folder window. Browse to the Manifest Processor directory 
and click OK to return to the Eclipse - Manifest Processor window with the directory 
displayed in the body of the window. 

4. In the body of the window, locate and click on the scanned manifest image that you want 
to process. 

5. Click the Process button to process the manifest and its signatures. 

• After successfully processing the manifest signatures, the system deletes the manifest 
from the Manifest Processor directory if you have the Delete successfully processed 
files option selected. 
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• If the system could not process any of the signatures on the manifest, it displays the 
Misreads for directory dialog box. Click the OK button and handle the misread error, 
as needed.  

6. Exit the window.  

See Also: 

Handling Misreads in Manifest Processor 

Auto-Processing Signatures with Manifest Processor 

Using Signatures Attached with Manifest Processor 

Creating Manifests for Manifest Processor 

Collecting Signatures for Manifest Processor 

Manifest Processor Setup Overview 

Manifest Processor Overview 
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Auto-Processing Signatures with Manifest Processor 
Use auto-processing to automatically process all manifests in the Manifest Processor directory 
simultaneously, instead of selecting one manifest to process separately. 

Upon opening the Manifest Processor application, browsing to the Manifest Processor directory, 
and selecting the auto-processing option, the system processes all manifests in the directory. It 
then continues to process all scanned manifests placed into the directory until the application is 
closed or the auto-processing option is de-selected. If the system cannot successfully process a 
signature, use the Misread function to identify and resolve the error.  

Before using auto-processing, set up you Manifest Processor directory and scanner. 

To auto-process signatures with Manifest Processor: 

1. Scan each signed manifest at 600 x 600 dots-per-inch (dpi) resolution, and store the 
scanned manifests in the Manifest Processor directory on your terminal or network. 

Note: If you have the Use faster (but less accurate) barcode scanning option 
selected, you can scan manifests at a lower dpi resolution. We do not 
recommend selecting this option. 

2. Display the Eclipse - Manifest Processor window on your terminal. 

3. In the Eclipse - Manifest Processor window, display the Manifest Processor directory by 
doing one of the following: 

• In the Directory field, enter the pathway for the Manifest Processor directory. The 
system displays the directory in the body of the window. 

• Click on the Browse For Folder icon – located to the right of the Directory field – to 
display the Browse For Folder window. Browse to the Manifest Processor directory 
and click OK to return to the Eclipse - Manifest Processor window with the directory 
displayed in the body of the window. 

4. Click the AutoProc button to display the Auto-Process dialog box. 

5. Click Yes to process all signed manifests in the Manifest Processor directory.  

• After successfully processing the manifest signatures, the system deletes the 
manifests from the Manifest Processor directory. 

• If the system could not process any of the manifests, the manifests remain in the 
Manifest Processor directory. Handle the misreads, as needed.   

Note: Once you select the Auto-Process option, the application continues to 
process manifests as soon as they are placed in the Manifest Processor 
directory. To discontinue auto-processing manifests, either click on the 
Process button or close the application.  

6. Exit the window.  
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Handling Misreads in Manifest Processor 
If the Manifest Processor cannot successfully read and process signatures on a manifest, you 
must identify the misread errors and manually process the signatures.  

Misread errors can occur when the Manifest Processor application cannot read a signature's 
barcode or cannot find a signature on a manifest. The application identifies the reason for the 
misread along with the file that it could not process.  

The application directs you in processing misread signatures: 

• Open the manifest file in the Misread function.  

• Select each misread signature. 

• Enter the invoice number to which the signature should be attached 

• Enter the cropping profile to use in capturing the signature.  

To handle misreads in Manifest Processor: 

1. Display the Eclipse - Manifest Processor window on your terminal. 

2. Click the Misreads button to display the Manifest Processor - Misreads window. 

The window displays the following information: 

Field Description 
Date The date and time on which the misread error occurred. 

File The file that was misread. 

Page The page number of the manifest on which the misread error occurred. 

Description The description of the misread error, such as Control barcode not found.  

 View Only 

3. Select the misread error that you want to resolve, and click the Review button to display 
the Misread Correction Form window. 

If the system prompts you with the Inverted Image dialog box, do one of the following: 

• Click Yes if the image is upside down.  

• Click No if the image is correctly displayed.  

The system displays the image right-side up, with the barcodes for the misread signatures 
highlighted in green. 

4. Select the misread signature by clicking near the upper-left corner of the signature area 
and dragging the mouse to the lower-right corner of the signature area. 

• The system highlights the selected area in yellow, and displays the selection in the 
Current Selection area of the window. 
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• To re-select the signature area, repeat step 4. The system deletes any previous 
selection. 

5. In the Sales Order Number field, enter the sales order number for the selected signature. 

6. In the Type of Selection field, enter the name of the cropping profile to define the area 
coordinates to capture.  

7. Click the Capture This Selection button to capture the signature. 

The system highlights the captured signature in blue.  

8. Repeat steps 4-7 for each misread signature on the manifest.  

The system displays the number of attachments captured and the total number of 
attachments for the misread manifest in the lower right side of the window. 

9. Click the Send Attachments button to process the misread signatures.  

The system displays the Transmitted Corrections dialog box when the signatures have 
been successfully processed. 

10. Click OK to close the Misread Correction Form window and return to the Manifest 
Processor - Misreads window. 

The misread manifest displays with a green check mark next to it to indicate that it was 
successfully processed.  

11. Select the processed manifest and click the Clear button to delete if from the Manifest 
Processor - Misreads window. 

Click the Clear All button to delete all misread manifests from the Manifest Processor - 
Misreads window. 

12. Click the Close button to save changes and exit the window.  

See Also: 

Processing Signatures with Manifest Processor 

Auto-Processing Signatures with Manifest Processor 

Manifest Processor Overview 
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Using Signatures Attached with Manifest Processor 
You can view attached Manifest Processor signature images from their invoices on the Eclipse 
system. In addition, you can also print, fax, or e-mail the invoices with the attached signatures.  

Note: You must have additional code installed with Document Imaging to print or 
fax invoices with attached signatures. You must have Outbound E-mail and 
VSI-FAX to e-mail and fax invoices with attached signatures. Contact 
Eclipse Advance Technical support for more information. 

To view an attached signature: 

1. From the Orders menu, select Sales Order Entry to display the Sales Order Entry 
screen. 

2. Display the invoice you want to view. 

3. Double click on the *i* – displayed in the upper right corner of the screen – to display the 
Attachments screen. 

4. Select the imaged signature from the list and press Enter to display the following: 

• The authorizing customer's signature and printed name. 

• Date signed. 

• Number of items delivered to the customer.  

5. After viewing the attached signature, click OK to return to the Sales Order Entry screen. 

6. Press F12 to exit the Sales Order Entry screen. 

To print, fax, or e-mail an invoice with its attached signature: 

1. From the Orders menu, select Sales Order Entry to display the Sales Order Entry 
screen. 

2. Display the invoice you want to view. 

3. Press Esc to display the Sales Order Status screen. 

4. For the generation to which the signature is attached, place the cursor in the Prt field. 

5. In the Prt field, press F10 and select one of the following: 

Selection Function 
Y – Yes Print Prints the invoice with the attached signature. 

Press Esc to print the invoice and return to the Sales Order Entry screen. 

F – Fax Faxes the invoice with the attached signature. 
• Press Esc to display the Fax Memo screen. 
• Populate the screen, as necessary. 
• Press Esc to send the fax and return to the Sales Order Entry screen. 
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Selection Function 
A – E-mail E-mails the invoice with the attached signature. 

• Press Esc to display the e-mail format prompt. 
• At the prompt, enter the format in which to send the e-mail and display the 

Send E-mail screen.  
• Populate the screen, as necessary. 
• Press Esc to send the e-mail and return to the Sales Order Entry screen. 

6. Press F12 to exit the Sales Order Entry screen. 

See Also: 
Processing Signatures with Manifest Processor 

Auto-Processing Signatures with Manifest Processor 

Manifest Processor Overview 

Opening File Attachments 

Using Indexer Menus 

Using Image Tools 
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Manifest Processor Setup Overview 
Before using Manifest Processor: 

• Install the Manifest Processor application onto all terminals that will be used to process 
and attach signatures.  

• If you do not already have the Document Imaging companion product, obtain and install 
it.  

• If you want to print or fax invoices with attached signatures, install the required code 
with Document Imaging.  

• If you want to e-mail or fax invoices with attached signatures, obtain Outbound E-mail 
and VSI-FAX, if necessary.  

Note: Your Eclipse installer should perform the above setup tasks. If these setup 
tasks were not completed with your initial installation, contact Eclipse 
Advance Technical support. 

After installing Manifest Processor, you must set up your Eclipse system, along with the 
Manifest Processor application. Define the following: 

• Control and authorization parameters on the Eclipse system.  

• Storage IDs and indexing profiles on the Eclipse system. 

• Manifest Processor options on the Manifest Processor application.  

• Manifest Processor cropping coordinates on the Eclipse system. 

See Also: 

Setup Requirements for Manifest Processor 

Setting Up Manifest Processor Options 

Setting Up Cropping Coordinates for Manifest Processor 

Manifest Processor Overview 

Signature Capture and Document Imaging Guidelines 
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Setup Requirements for Manifest Processor 
Following are the control maintenance records and authorization keys used for Manifest 
Processor.  

Control Maintenance Records 
Set up the following control maintenance records: 

Manifest Maintenance 
• Default Manifest Report Type 

• Manifest COD Message 

• Manifest Queue Enabled 

• Number Of Signatures/Barcodes Required On A Manifest 

• Print Shipping Instructions On Manifest 

• Print Status Override On Manifest Close 

• Print Status Override On Manifest Processor Signature Upload 

• Set Print Status When Order Placed On Manifest 

• Valid Package Types 

• Verify Ship Date/Ship Via For Ready To Manifest 

Authorization Key 
Assign the following authorization key: 

• IMG.EDIT.ALLOWED 
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Setting Up Manifest Processor Options 
Set up Manifest Processor options to define the network host and Eterm terminal to which 
Manifest Processor needs to communicate, along with the amount of time it tries to contact the 
host before timing out.  

In addition, define scanning resolution requirements of manifests, as well as storage options for 
manifest signature files.  

To set up Manifest Processor Options: 

1. Display the Eclipse - Manifest Processor window on your terminal. 

2. From the Tools menu, select Options to display the Manifest Processor - Options 
window. 

3. In the Eclipse Host area of the window, populate the following fields: 

Field Description 
Eclipse Host The network host to which you are uploading signatures. 

To access the host name, from Eterm select the Configure > Communications 
menu to display the Configure Communications window. The host name is 
displayed in the Host field.  

Service Port The network host port.  
To find the host port, display the Phantom Status screen. The port number is 
displayed in the Status field. 

Terminal ID The ID of the Eterm terminal on which the Manifest Processor application is 
installed. 
To access the Eterm terminal ID, from Eterm select the Configure > 
Communications menu to display the Configure Communications window. The ID 
is displayed in the ID field.  

4. Click the Test Connection button to make sure that the Manifest Processor is 
communicating correctly with the host. 

• If you set up communications correctly, the system prompts you with "Got reply, 
connection OK for processing." Click the OK button to continue. 

• If you set up communications incorrectly, the system prompts you with "Test 
connection attempt unsuccessful: Could not connect to xxx." Click the OK button to 
return to the Manifest Processor - Options window and re-enter the Eclipse host 
information. 

5. In the Misc Options area of the window, select the following as needed: 

Option Description 
Delete successfully processed 
files 

After a signature file has been processed and attached to its invoice, 
deletes it from the Manifest Processor directory in which it was 
stored.  
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Option Description 
Use faster (but less accurate) 
barcode scanning 

Allows you to scan in manifests at a resolution lower than 600 x 600 
dots-per-inch (dpi) resolution in order to process signature files more 
quickly. 

Note: If you select this option, signature files may not be processed 
or attached to invoices as accurately as if they had been scanned at a 
600 x 600 dpi resolution.  

Use persistent socket services Uses socket communications to connect to the host. 

Note: We recommend that you select this option.  

6. In the Network Timeout field, drag the button to define the number of seconds that the 
Manifest Processor application will try to contact the host before timing out. 

7. Click the OK button to save the settings and exit the window. 

See Also: 
Manifest Processor Setup Overview 
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Setting Up Cropping Coordinates for Manifest 
Processor 
Set up Manifest Processor cropping coordinates to define to the system the area on signed 
manifests that needs captured and attached to invoices.  

There are two steps in setting up cropping coordinates: 

• Calculating – To calculate cropping coordinates, you need to create, print, and scan a 
sample manifest with barcodes and signatures. Using the Manifest Processor application 
and this sample, select the area on manifests to crop and to calculate that area's 
coordinates.  

• Defining – In Barcode Manifest Maintenance, define the cropping coordinates to the 
Eclipse system based on the Manifest Processor's calculations. The system uses these 
coordinates to capture all Manifest Processor signatures, unless the settings are de-
activated. 

To calculate cropping coordinates for Manifest Processor: 

1. Create and scan a sample signed manifest with barcode. 

2. Display the Eclipse - Manifest Processor window on your terminal. 

3. In the Eclipse - Manifest Processor window, display the Manifest Processor directory by 
doing one of the following: 

• In the Directory field, enter the pathway for the Manifest Processor directory. The 
system displays the directory in the body of the window. 

• Click on the Browse For Folder icon – located to the right of the Directory field – to 
display the Browse For Folder window. Browse to the Manifest Processor directory 
and click OK to return to the Eclipse - Manifest Processor window with the directory 
displayed in the body of the window. 

4. In the body of the window, locate and click on the sample manifest image. 

5. From the Tools menu, select Cropping Location Tool to display the Locating Form – 
Control File Settings window.  

6. Click near the upper-left corner of the signature area and drag the mouse to the lower-
right corner of the signature area. 

• The system highlights the selected area in yellow and the corresponding barcode in 
green. This is the area that the system will crop for all signatures. 

• To re-select the signature area, repeat step 6. The system deletes any previous 
selection. 
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7. When you have the area selected, click on the Calculate button to display the Control 
File Settings window. 

This window displays the coordinates for the selected area.  

8. Keep this window open, as you will use it to populate the cropping coordinates in the 
Eclipse system. 

To define cropping coordinates in the Eclipse system: 

1. Calculate the cropping coordinates. 

2. Display Eterm on your terminal. 

3. From the System > System Files menu, select Manifest Settings to display the Barcode 
Manifest Maintenance screen. 

4. In the Profile/New field, enter new to display a list of current profiles. 

5. In the list, select New and press Enter. 

6. In the Profile/New field, enter a name for the cropping profile, such as Manifest Sigs. 

7. Populate the following fields with the information provided in the Control File Settings 
window: 

Field Description 
Offset X From the Control File Settings window, copy the value for X into this field. 

Offset Y From the Control File Settings window, copy the value for Y into this field. 

Width From the Control File Settings window, copy the value for Width into this 
field. 

Height From the Control File Settings window, copy the value for Height into this 
field. 

Character Count From the Control File Settings window, copy the value for Character 
Count into this field. 

Document Storage 
Profile 

Enter the document storage profile in which manifest signatures will be 
stored.  

Enabled Enter Yes to enable this cropping profile. 
If you want to use another cropping profile, enter No for the current profile 
and enable the other profile.  

8. On the Control File Settings window, click the OK button to close the window. 

9. Close the Locating Form – Control File Settings window, and delete the sample manifest 
from the Manifest Processor directory. 

10. From Eterm, press Esc to save changes and exit the Barcode Manifest Maintenance 
screen. 

See Also: 
Setting Up Manifest Processor Options 
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